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Helping Senior Citizens Reveals Past 
Apple Lapses and Recent Improvements 

by  ADAM ENGST 

Over the last few weeks, I’ve spent some time helping my late friend Oliver’s elderly father JP and his 
wife Gretel, who are preparing for a move to an assisted-living apartment in another state (see “Oliver 
Habicht Dies of Pancreatic Cancer at 53,” 26 September 2020). They’re internationally renowned sci-
entists in nutritional epidemiology and nutritional anthropology, and while they’re both suffering the 
seemingly inevitable physical ravages of age, they remain fully mentally competent, if occasionally slowed 
by medications and fatigue. 

I had promised Oliver that I’d stand in for him as necessary, and since he had been JP and Gretel’s pri-
mary tech support person for years, I was happy to help when they said they had some computer ques-
tions. I knew what I was getting into, more or less, since JP was one of my first consulting clients in 1987 
when I was a junior at Cornell and he lived just a block away. I’d go over, decipher the notes he left himself 
by naming empty folders on his Mac Plus, and help him work through various software and hardware 
problems. 

We had time for only a few visits before they were slated to leave, and their house was being packed up 
around us, so they had three areas to focus on: dealing with old hardware, rationalizing their backup strat-
egy, and coming up with a better password management system. In each case, I was struck by the fact that 
Apple has put some effort into addressing these problems recently, but in ways that won’t necessarily help 
older Mac users who aren’t using the latest hardware, operating systems, and technologies. 

I don’t want to make over generalizations about people in their 70s, 80s, and 90s, since we have many 
highly technical and capable TidBITS readers in those age ranges (not to mention our centenarian—see 
“George Jedenoff: A 101-Year-Old TidBITS Reader,” 17 June 2019 and “102-Year-Old George Je-
denoff Publishes His Autobiography,” 26 August 2019). But from what I’ve observed among the 
mainstream public, it’s increasingly common for the elderly to rely heavily on computers, tablets, and 
smartphones but have trouble with the constant change in the tech world. It’s not that the systems are 
necessarily too hard (though some could improve); it’s that there is too much to learn and it changes too 
frequently. Plus, those who have been using technology for decades tend to have a lot of older hardware 
around, further complicating upgrade and compatibility questions. 

It’s tempting to fall back on that old saw, “If it ain’t broke, don’t fix it,” and sometimes that’s true. But in 
the tech world, staying put often isn’t feasible. Some apps really do break purely from age (like 32-bit apps 
in macOS 10.15 Catalina), some updates require new minimum hardware and operating systems, and 
compelling capabilities appear in new and revised apps. Some level of change is inevitable, but everything 
gets harder when that change has been delayed for years. Here’s what I encountered. 

Old Hardware 
On my first visit, JP and Gretel had a box of random tech bits—keyboards, mice, USB hubs, power 

supplies—labeled with my name on a sticky note. (Sticky notes were everywhere, in fact, since they’re 
excellent reminders, and JP has long fit the mold of the absent-minded professor.) They also had an old 
MacBook Air, Mac mini, iMac, Dell PC tower, and PC subnotebook, all of which were weighing on 
them. None were in use, but they’d been kept instead of recycled in part because it’s hard to decommission 
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an old computer soon after getting a new one. You never know if you might need the old one for something, and regardless of whether the machine 
has value to anyone, it’s important to erase the internal drive before disposing of it. 

It was my job to erase the drives and get rid of the machines. Given the age of these machines, that’s proving more difficult than I anticipated. The 
2010 MacBook Air was easy: I booted into macOS Recovery, reformatted the SSD, and reinstalled macOS. We even have a friend who wants to 
adopt it. But while I was able to erase the iMac’s hard drive, it insisted on having my Apple ID to install 10.11 El Capitan, and the installation con-
tinually fails. Although the Mac mini seemingly boots, I haven’t yet been able to get it to drive a display, so I can’t see what’s on the screen or erase its 
drive. (Several folks have helpfully suggested Target Disk Mode, which I plan to employ when I return to the project.) I haven’t gotten to the PCs yet
—they may end up being drilled and recycled. 

My point here is that if preparing a computer for disposal is this involved for someone with my experience, knowledge, and hardware (and the 
strength and flexibility to move computers and screens around), it will be beyond many older people. That’s especially true because cleaning off a 
Mac to dispose of it isn’t something that anyone other than a consultant or IT admin will do frequently. 

Happily, this is one of those situations where Apple is moving in the right direction. First, the company encourages users to trade in or recycle old 
hardware. Second, starting in macOS 12 Monterey, Apple has made it easier to prepare a Mac to be passed on, albeit in a rather hidden fashion. 

Here’s how you’ll prep a Mac for a new life if it’s running Monterey (this requires an M1 Mac or an Intel-based Mac with a T2 security chip). 
Open the System Preferences app, but instead of working inside its window, as you normally do, choose System Preferences > Erase All Content and 
Settings to start the Erase Assistant. 
After clicking Continue, it quits all 
your apps and proceeds with eras-
ing all the data. Or at least I as-
sume so since I didn’t let it erase 
my 27-inch iMac’s boot drive. 

Alas, many older users may not 
have Macs that meet these re-
quirements. For other Macs, hold 
Command-R at boot to start 
macOS Recovery, from which you 
can use Disk Utility to erase the 
boot volume and then reinstall a 
clean version of macOS. 

Better Backups 
As long-time Mac users with 

advice from Oliver, who was an IT 
professional, JP and Gretel both 
had Time Machine drives for local 
versioned backups and offsite 
backups to IDrive. They under-
stood the importance of offsite 
backups but weren’t happy with 
IDrive and wanted a new Internet 
backup service. They were also 
laboring under two common confusions about backups: 
• They wanted to know if they could store other files on their capacious Time Machine drive. Technically, that’s possible (see “How to Use Extra 

Space on an APFS Time Machine Drive,” 20 May 2022), but it’s a bad idea to mix backups and original data on the same physical drive, partic-
ularly for people who don’t have a crisp awareness of how to maintain multiple backup systems. 

• Along with IDrive, they were paying for extra storage on Dropbox and Google Drive and wanted to know if they could back up to that storage. 
Again, it’s technically possible, but both provide online syncing and storage, not true backup. For backup with versioning and protection against 
file deletion, a backup app is necessary. 
After talking it through, and taking into account that they were leaving the area shortly, I set them up with Backblaze for $70 per computer per 

year and helped them turn off auto-renewal on the IDrive account. They also dropped their Dropbox accounts to the free level, but stuck with the 
lowest level Google One storage plan to ensure enough space in Gmail. 

Continued from page 1

https://www.apple.com/shop/trade-in
https://www.apple.com/shop/trade-in
https://tidbits.com/2022/05/20/how-to-use-extra-space-on-an-apfs-time-machine-drive/
https://tidbits.com/2022/05/20/how-to-use-extra-space-on-an-apfs-time-machine-drive/
https://www.backblaze.com/cloud-backup.html
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Backblaze is a good sys-

tem, particularly in the set-
and-forget category, which 
is essential for elderly folks 
who don’t need to spend 
more time managing their 
backups. The main prob-
lem JP and Gretel had 
initially was the disconnect 
between the Backblaze 
preference pane on the 
Mac and its Web-based 
interface for additional 
management and file 
restoring. They also fell 
prey to the watched-pot 
problem of the first back-
up, which took a few days 
to complete. 

Apple has addressed the 
need for backups for iOS 
and iPadOS with iCloud 
Backup, but I remain sur-
prised that the company 
hasn’t released an iCloud Time Machine that would back up Macs to paid iCloud+ storage (see “Five Enhancements for Future Apple Operating 
Systems,” 19 May 2022). Such a built-in system would encourage more Mac users—regardless of age—to protect their data since they wouldn’t need 
to buy an external drive, and it could serve as an offsite backup for those who already use Time Machine locally. 

Shared Passwords 
The final area of concern surrounded passwords. I don’t know why, but JP and Gretel had never previously made the jump to a password manager. 

Part of that may have been JP’s idiosyncratic note taking habits and Gretel’s excellent memory (when signing up for Backblaze, she was able to rattle 
off her entire American Express credit card number, expiration date, and CVC code with no difficulty). Nonetheless, Gretel was aware that she might 
not remember a one-off password or fact, so she fell back on handwritten reminders on sheets of notebook paper. Similarly, though more digitally, JP 
maintained a Word document with coded notes that described his passwords for different sites such that only he or someone who knew him well 
would be able to figure out the passwords. He had recently shared that document with family members but was aware that better solutions existed. 

Moving elderly people to a password manager worries me. Password managers are better in every way—they’re faster, easier, more secure, more 
easily shared, and a boon for multiple device use—but they require learning an entirely new way of logging into websites, which seems to be tough. If 
a password manager causes more login friction than it saves, it will become more trouble than it’s worth. 

Initially, I was thinking it would make more sense to help them come up with a better low-tech solution for backup and set Google Chrome to save 
passwords for them, but JP was insistent on setting up LastPass and sharing it with members of his family. We did that, and I showed him how Last-
Pass asks to record newly created or updated logins, but I have some trepidation that it may not work out long-term. It’s possible that Apple’s Pass-
words and iCloud Keychain would have been a viable alternative, particularly with Apple’s account recovery contacts and Legacy Contacts, but 
Apple’s solution lacks the sharing features of LastPass and 1Password that make them compelling to families who might need to access the accounts of 
relatives who become incapacitated or pass away. 

The ultimate solution is of course passkeys, which are both easier and more secure than passwords, but I fear that older folks will have trouble ad-
justing to yet another new authentication system (see “Why Passkeys Will Be Simpler and More Secure Than Passwords,” 27 June 2022). If JP 
and Gretel are at all representative of their generation, the biometric aspects of passkeys may not be as much of a win for older people as well—Touch 
ID fails for both of them, and I’ve seen suggestions that fingerprint scanning accuracy decreases with age due to skin becoming smoother and less 
elastic. Face ID shouldn’t suffer such issues, but plenty of Apple devices continue to rely on Touch ID. 

So, again, it looks like Apple is moving in the right direction with password management, passkeys, and recovery options, but it may be too late for 
those who lack compatible hardware or for whom a new way of authenticating may be overly challenging.

https://tidbits.com/2022/05/19/five-enhancements-for-future-apple-operating-systems/
https://tidbits.com/2022/05/19/five-enhancements-for-future-apple-operating-systems/
https://support.apple.com/en-us/HT212513
https://support.apple.com/en-us/HT212360
https://tidbits.com/2022/06/27/why-passkeys-will-be-simpler-and-more-secure-than-passwords/
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Can’t wait for the next newsletter to see what the guys and gals at Joy of Tech are up to? Then simply go on over to their 
website and see past and current cartoons and other things

http://www.joyoftech.com/joyoftech/
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Bringing Back Keyboard Flags in macOS 12.4 Monterey 
by JOSH CENTERS 

When Apple released macOS 12.4 Monterey, it 
seemed like a minor update (see “Apple Releases iOS 
15.5, iPadOS 15.5, macOS 12.4, watchOS 8.6, 
tvOS 15.5, and HomePod Software 15.5,” 16 May 
2022), but it included a small undocumented change 
that has irritated some users: it removed the colorful 
national flags associated with each keyboard input 
source. Previously, in System Preferences > Keyboard > 
Input Sources, you would see an American flag for the 
US keyboard, a Canadian flag for the Canadian English 
keyboard, a British flag for the British keyboard, and so 
on. 

More importantly, you would also see these flags in 
the menu bar’s Input menu, with the currently selected 
keyboard’s flag as the 
menu icon. 

With macOS 12.4, 
Apple chose to replace 
the flags with drab, 
monochromatic blocks 
containing a one- or 
two-character code to 
identify keyboards, 
which are nowhere 
near as visually distinct. 

Apple has seemingly 
been on a war against 
color for years, most notably with respect to Finder window sidebar icons. However, Daring Fireball’s John Gruber says that a “little birdie” told him 
it was a deliberate move on Apple’s part to avoid denoting languages using national flags. 

That makes some sense because languages aren’t always neatly tied to countries. But why now, after decades of presenting input languages this way? 
Especially considering that macOS has long used these little blocks to distinguish 
languages that don’t correspond to countries, such as Cherokee and Uyghur, and 
even some languages that seem to match up, like Japanese and Thai. 

Regardless, several simple apps can restore the colorful flags to your menu bar. 

Keyboard Flag Solutions 
John Gruber highlighted a couple of App Store apps to solve this problem: 

the $0.99 Colorful Input Menu Flags and the $1.99 Keyboard Switcheroo. 
Neither app collects personal data. I decided to try out Keyboard Switcheroo on 
Gruber’s recommendation since he felt it was the more polished of the two. 

Keyboard Switcheroo works much like Apple’s old Input menu, with the key 
exception being a first-launch splash screen that offers basic instructions and 
prompts you to start Keyboard Switcheroo at login. Click Get Started to bypass 
that, and if you ever need to bring it back, choose Options > Help from the 
Switcheroo menu. 

When I first installed Keyboard Switcheroo, it placed the icon at the far left of 
the menu bar. You can hold down Command and drag a menu bar icon to 

Macs & macOS

https://tidbits.com/2022/05/16/apple-releases-ios-15-5-ipados-15-5-macos-12-4-watchos-8-6-tvos-15-5-and-homepod-software-15-5/
https://tidbits.com/2022/05/16/apple-releases-ios-15-5-ipados-15-5-macos-12-4-watchos-8-6-tvos-15-5-and-homepod-software-15-5/
https://tidbits.com/2022/05/16/apple-releases-ios-15-5-ipados-15-5-macos-12-4-watchos-8-6-tvos-15-5-and-homepod-software-15-5/
https://tidbits.com/2022/05/16/apple-releases-ios-15-5-ipados-15-5-macos-12-4-watchos-8-6-tvos-15-5-and-homepod-software-15-5/
https://daringfireball.net/linked/2022/06/14/macos-12-input-menu-flags
https://daringfireball.net/linked/2022/06/14/macos-12-input-menu-flags
https://daringfireball.net/2022/06/two_new_apps_to_flag
https://apps.apple.com/us/app/colorful-input-menu-flags/id1630533969?mt=12
https://apps.apple.com/us/app/keyboard-switcheroo/id1630573891?mt=12
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move it wherever you want, apart from the locked right-most positions. 
If you choose Edit from Keyboard Switcheroo’s menu, you can add languages directly 

without delving into System Preferences. (Note that changes in Keyboard Switcheroo aren’t 
reflected in System Preferences and vice versa.) You can also customize the language icons, 
choosing from the standard flag image, the flag’s emoji, text labels, or any image on your 
Mac. 

So there you have it: a simple solution for a small but potentially annoying change in 
macOS 12.4. 

Apple Enhances HomeKit with Sensor-Based Automations and Timed Turn Offs 
by JOSH CENTERS 

Before I wrote Take Control of Apple Home Automation, I documented here in TidBITS how I set up my dehumidifier to turn on automatical-
ly whenever the humidity in our underground TV room rose to an unacceptable level (see “A Prairie HomeKit Companion: The Elgato Eve 
Room” 19 June 2017). In short, my Eve Room monitored the humidity level, and I set up an automation to turn on an Eve Energy outlet connect-
ed to our dehumidifier. At the time, the problem was that Apple’s Home app didn’t recognize the Eve Room as a sensor for automations, so I had to 
jump through some convoluted hoops with Eve’s HomeKit app. 

While finally updating the book (waiting for the Matter partnership to materialize might not have been the best move; see “Home Automation 
Standard Gets an Official Name,” 17 May 2021), I took the opportunity to revisit that automation and take advantage of some subtle yet impor-
tant changes to the Home app. In iOS 15.1, Apple finally made it so sensor-based automations could be triggered based on air quality, humidity, or 
light level (see “Apple Releases macOS 12 Monterey with iOS 15.1, iPadOS 15.1, watchOS 8.1, tvOS 15.1, and HomePod Software 15.1,” 25 
October 2021). 

With the right sensors, this new capability can open up a world of possibilities, and if you have a lot of HomeKit accessories, you may have more 
sensors than you realize. 

The Hidden Sensor 
In my old setup, I used an Eve Room to monitor humidity. It does other neat things, too, like track air quality and temperature. There’s only one 

problem: I can’t find it. It’s small, has little buttons and a screen, and has to be put in a prominent place, so my best guess is my kids started playing 
with it and left it somewhere. 

Thankfully, while exploring Automation settings, I discov-
ered that my Ecobee thermostat has a secret humidity sensor. 
The thermostat doesn’t appear as an accessory in the Home 
app, but I can query Siri about the humidity in my kitchen, 
where the Ecobee thermostat is installed, and it shows up as a 
sensor for automations, as you’ll see in the next section. It’s 
not in the same room as my dehumidifier but only a few feet 
away. Plus, it runs off my HVAC system’s power instead of a 
battery, so that’s one less thing to worry about. And since it’s 
attached to the wall, my kids won’t mess with it. 

So before you go buying new sensors for automations, it’s 
worth checking in the Home app to see if you have sensors 
you didn’t know about. 

Creating a Sensor-Based Automation 
With all that out of the way, recreating my old automation was simple. If you’d like to do something similar, here’s how. 
Open the Home app on an iPhone, iPad, or Mac, tap the + icon (below left), tap Add Automation, and then tap A Sensor Detects Something 

(below right). (If that option is grayed out, you don’t have any sensors available.) 

https://www.takecontrolbooks.com/apple-home-automation?pt=TIDBITS
https://tidbits.com/2017/06/19/a-prairie-homekit-companion-the-elgato-eve-room/
https://tidbits.com/2017/06/19/a-prairie-homekit-companion-the-elgato-eve-room/
https://tidbits.com/2021/05/17/home-automation-standard-gets-an-official-name/
https://tidbits.com/2021/05/17/home-automation-standard-gets-an-official-name/
https://tidbits.com/2021/10/25/apple-releases-macos-12-monterey-with-ios-15-1-ipados-15-1-watchos-8-1-tvos-15-1-and-homepod-software-15-1/
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  The next screen displays the available sensors 
in your home. Not all are well labeled—as 
you can see in the left screenshot below—so 
you have to learn how to read the icons: 
• Thermometer: Temperature 
• Green person: Motion 
• Orange person: Occupancy (similar to 

the motion sensor, but less sensitive) 
• Water drop: Humidity 
• Wavy lines: Air quality 
  Tap a sensor to select it; you can choose only 
one sensor per automation. Tap Next to set 
up how to trigger the automation (below 
right). The details vary for every type of sen-
sor, but they should be easy to understand. 
For instance, you can set a motion sensor to 
trigger based on whether or not it senses mo-
tion. For humidity, you can set a humidity 
percentage and then set the automation to 
trigger if it rises above or drops below that 
percentage. 

At the bottom, you see settings for Time and 
People, which let you fine-tune the automation. 
Time lets you set times when the automation can 
trigger. By default, that’s any time, but you can set 
it for day, night, or specific hours. The People 
setting lets you trigger an automation based on 
who is home. 

I used to caution users about the People setting 
because it didn’t work well in situations where 
cellular service was weak or nonexistent, like my 
house. That has improved since iOS 14, so I use 
it more now, primarily with low-impact automa-
tions like setting my cameras to record only when 
we’re out of the house. However, remember that 
Apple’s definition of “people” in this case is 
iPhone users in your Family Sharing group, so 
you still have to be careful. For instance, if we set 
it so the lights would turn off when we left home, 
heading out for date night could leave the 
babysitter and our kids in the dark. 

Once you have the criteria set, tap Next for a 
screen of all the scenes and accessories that the 
automation can trigger (below left). Tap those you want to include. Don’t worry yet about specifying what the accessory will do. After you have se-
lected all the right accessories, tap Next, which brings you to the final screen (below right). 
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On the last screen, you can tap the top field to rename the 

automation, but most importantly, pay attention to the 
accessory tiles, which let you set what they do. For most 
accessories, a tap sets them to turn on or off. As with normal 
accessory control, you can long-press (or Control-click on 
the Mac) to fine-tune actions. 

Automatically Turn Off Automations 
I want to call your attention to another automation im-

provement that you’ll find at the bottom of this final screen: 
Turn Off, another worthwhile enhancement that Apple has 
made to HomeKit automations. After an automation turns 
on an accessory, the Turn Off feature enables it to turn the 
accessory off after a specified length of time. 

Turn Off turns out to be useful in many contexts. Let’s say 
you want a motion sensor to turn on a light at night when 
you stumble out of bed to go to the bathroom. Previously, 
there was no simple way to turn that light off, but now the 
automation can automatically turn it off after a few minutes. 

I’m using that setting to further streamline my dehumidi-
fier system. Previously, I had set up two automations: one to 
turn the dehumidifier on once the humidity rose to a certain 
level and another to turn it off after the humidity dropped 
below another level. Now, instead of the second automation, 
I can set the dehumidifier to turn off after an hour. If the 
humidity is still high, it’ll kick back on. 

Helpful as timed Turn Off is, it reveals a gap in the Home app’s capabilities. What we really need is for automations to be able to turn themselves 
off in the same ways they turn themselves on. So, for humidity, it could turn on when the level rises above 60% and off when it drops below 40%. 
Or, an automation triggered by a motion sensor could turn off a set number of minutes after motion is no longer detected. 

In any case, I’ve hopefully given you some ideas for how to take more advantage of HomeKit in your home. 

Apple Brings Mail Merge Back to Pages 
by GLENN FLEISHMAN 

After nearly a decade, Apple has finally brought mail merge back to Pages. Apple removed the feature from the iWork suite as part of the funda-
mental rewrite of Pages, Numbers, and Keynote in 2013. A concept dating back at least four decades, mail merge lets you insert placeholders in a 
template document that are replaced with entries in a column of data in a spreadsheet or similar tabular format. It’s commonly used to generate form 
letters, address labels, and name tags. 

Microsoft Word has always had mail merge, but it’s far more complicated than the last time I used it. I recently wrestled with Word to produce 
shipping labels for a Kickstarter project’s rewards, and every step was painful, despite its built-in templates for Avery labels. (Avery is a major producer 
of printable labels in all varieties.) What I remember as a quick set of clicks and formatting in the 1990s and 2000s took hours of fiddling to produce 
something that still didn’t look exactly like I wanted. 

Other options have disappeared. I used BeLight’s Labels & Addresses app for years, but the company opted not to upgrade it to 64-bit compati-
bility, so it died with macOS 10.15 Catalina. To its credit, BeLight gave users a free license to Swift Publisher, its desktop publishing software, which 
has some rudimentary tools for mail merge. But despite the effort BeLight put into the feature, I found it more painful than Word to use when 
merging from spreadsheet data. It’s easier if you only want to merge from Contacts. 

Apple’s revived mail merge in Pages 12.1 is utter bliss, both on its own and by comparison to Word and Swift Publisher. That’s good news because 
many people don’t have a license for either of those apps. 

The bad news? You can merge “letters, cards, and envelopes,” according to Apple. That is, page-based documents. Pages doesn’t yet handle labels or 
any blocks of placeholders that would require inserting multiple records on a single page that fill with the next item from the data source. 

My ultimate solution for printing labels after many, many hours of testing was Avery’s Design & Print service (free account required), which is 
clever but limited. If you’re printing entries only from your contacts, Apple’s Contacts app offers built-in label printing with selectable Avery and 
DYMO templates. However, if you have page-based documents to merge, Pages has become your best option. 

https://www.swiftpublisher.com/
https://www.avery.com/software/design-and-print/
https://support.apple.com/guide/contacts/print-mailing-labels-envelopes-contact-lists-adrbab40ca1d/mac


11
Getting Started 

Start with mail merge in Pages by opening an existing document or creating a blank one. Keep the document in word-processing mode; if you 
choose File > Convert to Page Layout, mail merge becomes unavailable. 

Click the Document icon at the far right of the toolbar to change the page dimensions, such as to an envelope or note size. Once you’re set, in the 
Document sidebar, click Mail Merge at the bottom to reveal the Mail Merge options sidebar. (My examples here are with Pages for macOS, but 
Apple also brought mail merge to Pages for iOS and iPadOS.) 

 
You can merge with data from Contacts or a spreadsheet, as I explain in the next two sections. 
Merge from Contacts 
In the Mail Merge pane at the right, you can populate your document with fields that will be replaced by data: 

 
1. Position your cursor in the text where you want the field to go. 
2. Click Add Merge Field in the Mail Merge pane. (You can instead choose Insert > Mail Merge Field.) 
3. The fields listed come from the Contacts app. Choose an item from the list or More Fields, which lets you drill down into other contact fields. 

(Note that multi-line entries, like an address, will insert hard returns at the ends of lines, like the address line; see a tip below.) 
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4. When you’re finished adding fields, click the Merge button 

at the top of the pane to open the Mail Merge dialog. 

5. You can draw your data from All Contacts or filter by groups. (If the 
group you need doesn’t exist, go to the Contacts app, and create and 
populate it.) 

6. Click Preview to see what data will be filled in for each merged entry. 
Click Close to exit the preview. 

7. If the preview looks correct, click Merge. Pages creates a new docu-
ment with one page for each merged item. 

8. Save your merged document. 
9. You can now print the docu-

ment as a series of pages, cards, 
or envelopes. 

A few tips related to the 
right: 
•   You can access additional ad-

dress options by drilling down 
in More Fields. Choose More 
Fields > Address and then one of 
the kinds of addresses, like 
home, and then you can select 
the full address as a multi-line 
entry or a single line without 
line breaks, or you can pick in-
dividual components of an ad-
dress, like city and state. 

• Mail merge documents can 
have multiple pages, which is 
useful for longer form letters. 
The Mail Merge pane shows the 
page number on which a field appears to the right of the field’s name in the fields list. 

• While you can’t create labels, you could use a combination of Avery’s free downloadable Pages templates and mail merge. Create the mail 
merge, produce the merged document, open the Avery template and save it under a new name, and then copy and paste from the merged doc-
ument into the fields on the Avery template. Tedious for hundreds of labels, but not too terrible for a handful! 

• When creating an envelope, even though you can’t switch to Page Layout mode, you can add a text box. I click the Text icon in the toolbar, drop 
my return address into that text box, and drag and resize it to the space I want in the upper-left corner. I make the return address text box fill the 

https://www.avery.com/templates
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whole left side of the 
envelope because Pages’ 
built-in text wrap will 
then let me push the 
left edge of the ad-
dressee to where I want 
it.  

• Set up an envelope 
with your return ad-
dress in a text box to 
control the position of 
the addressee’s delivery 
address. 

M e r g e U s i n g a 
Spreadsheet 

Merging from your contacts is useful, but what about from a spreadsheet? It’s pretty much a breeze, too. Follow these steps: 
1. As with a Contacts-based merge, position your cursor in the 

text. 
2. Click the Add Merge Field in the Mail Merge pane. 
3. Choose Add from Spreadsheet at the top of the menu. 
4. Select a Numbers document and click Open. 
5. Choose the desired table of source data from the Table field, 

which previews the fields that will be imported. If the Num-
bers spreadsheet contains multiple sheets, Mail Merge lists 
them as sheet name:table name. (You can also switch to a dif-
ferent spreadsheet by clicking Change.) 

6. Click Add as Fields. 

7.These fields now appear as items you can choose from the Add Merge 
Field menu in Step 3 in the previous instructions. 
 There’s no filtering option: your Numbers document must contain 
just the entries you want to merge. 

Room for Improvement with Hope It Will Happen 
There’s plenty of room for improvement in mail merge, but I count this 
as a stellar return engagement. Apple has consistently paid modest atten-
tion to its productivity apps, particularly in the last few years, often 
adding features or cleaning up around the edges. 
What else would I like to see? 
• Support for labels—the templates are already in Contacts!—and oth-

er repeating items on the same page 
• Allow mail merge fields in Page Layout documents 
• Link Numbers and Pages so you can mark fields in Numbers and 
export to create a merged Pages document directly 
What mail merge capabilities would you like to see in Pages?macOS 
11.6.7 Big Sur Fixes Email Attachment Bug 

macOS 11.6.7 Big Sur Fixes Email Attachment Bug 
by ADAM ENGST 

I’m a little late to this party because all my main Macs are running macOS 12 Monterey, but about two weeks ago, Apple quietly released macOS 
11.6.7 Big Sur separately from other updates. The release notes are the first since macOS 11.5 that provide any useful detail, noting that the update 

https://support.apple.com/en-us/HT211896
https://support.apple.com/en-us/HT211896


Why Passkeys Will Be Simpler and More Secure Than Passwords 
by GLENN FLEISHMAN 

Apple has unveiled its version of passkeys, an industry-standard replacement for passwords that offers more security and protection against hi-
jacking while simultaneously being far simpler in nearly every respect. 

You never type or manage the contents of a passkey, which is generated when you upgrade a particular website account from a password-only or 
password and two-factor authentication login. Passkeys overcome numerous notable weaknesses with passwords: 
• Each passkey is unique—always. 
• Every passkey is generated on your device, and the secret portion of it never leaves your device during a login. (You can securely sync your passkeys 

across devices or share them with others.) 
• Because passkeys are created using a strong encryption algorithm, you don’t have to worry about a “weak” password that could be guessed or 

cracked. 
• A website can’t leak your authentication credentials because sites store only the public component of the passkey that corresponds to your login, 

not the secret part that lets you validate your identity. 
• An attacker can’t phish a passkey from you because a passkey only presents itself at a legitimately associated website. 
• Passkeys never need to change because they can’t be stolen. 
• Passkeys don’t require two-factor authentication because they incorporate two different factors as part of their nature. 

After a test run with developers over the last year, Apple has built passkey support into iOS 16, iPadOS 16, macOS 13 Ventura, and watchOS 9, 
slated for release in September or October of this year. These operating systems will store passkeys just as they do passwords and other entries in the 
user keychain, protected by a device password or passcode, Touch ID, or Face ID. Passkeys will also sync securely among your devices using iCloud 
Keychain, which employs end-to-end encryption—Apple never has access to passkeys or other iCloud Keychain data. 

Best of all, perhaps, is that Apple built passkeys on top of a broadly supported industry standard, the W3C Web Authentication API or WebAu-
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fixes a problem in macOS 11.6.6 with opening 
email attachments if the app required to open 
the file was already active. Users received error 
messages claiming they didn’t have the necessary 
permissions. 

TidBITS Talk user chs had trouble printing 
after updating to macOS 11.6.7 on an M1 
MacBook Air; it seems that their installation of 
Rosetta was removed as part of the update such 
that they had to reinstall it to enable the Brother 
printer driver (although an update to the native 
Brother software might also have resolved the 
issue). Will M also noted that, after updating to 
11.6.7, Time Machine completed the first 
backup to his Time Capsule since he had in-
stalled 11.6.5 in April. 

In short, for those still using Big Sur, it’s 
worth updating to macOS 11.6.7 using Soft-
ware Update to address the email attachment bug and potential Time Machine blockages, but beware that you might need to reinstall Rosetta. Or 

https://talk.tidbits.com/t/if-you-are-on-big-sur-get-11-6-7-update-asap/19269/5?u=ace
https://apps.apple.com/us/app/brother-iprint-scan/id382775642
https://apps.apple.com/us/app/brother-iprint-scan/id382775642
https://support.apple.com/en-us/HT213305


15
thn, created by the World Wide Web Consortium and the FIDO Alliance, a group that has spent years developing approaches to reduce the effec-
tiveness of phishing, eliminate hijacking, and increase authentication simplicity for users. Apple, Amazon, Google, Meta (Facebook), and Microsoft 
are all FIDO board members, as are major financial institutions, credit card networks, and chip and hardware firms. 

Many websites and operating systems already support WebAuthn via a hardware key like the popular ones made by Yubico. You visit a website, 
choose to log in using a security key, insert or tap a button on the hardware key, and the browser, operating system, and hardware key all talk to-
gether to complete the login. A passkey migrates the function of that hardware key directly into the operating system—no extra hardware required. 
Websites that already support hardware-based WebAuthn should be able to support passkeys with little to no effort, according to Apple. 

Before we get started, note that Apple writes “passkey” in lowercase, an attempt to get us to use it alongside password, passcode, and passphrase as 
a common concept. Google, Microsoft, and other companies will offer compatible technology and may also opt for the generic passkey name. 
While new terminology can cause confusion, “passkey” is better than the more technically descriptive “multi-device FIDO credentials,” which 
doesn’t exactly roll off the tongue. 

Let’s dig in to how passkeys work. 

Passkeys Bring the Benefits of Public-Key Cryptography to Everyday Logins 
Passkeys rely on public-key cryptography, something we’ve been writing about at TidBITS for nearly 30 years. With public-key cryptography, an 

encryption algorithm generates a secret that’s broken into two pieces: a private key, which you must never disclose, and a public key, which you can 
share in any fashion without risk of exposing the private key. Public-key cryptography underpins secure Web, email, and terminal connections; 
iMessage; and many other standards and services. 

Anyone with a person’s public key can use it to encrypt a message that only the party who possesses the private key can decrypt. The party who 
has the private key can also perform a complementary operation: they can “sign” a message with the private key that effectively states, “I validate 
that I sent this message.” Crucially, anyone with the public key can confirm that only the private key’s possessor could have created that signature. 

A passkey is a public/private key pair associated with some metadata, such as the website domain for which it was created. With a passkey, the 
private key never leaves the device on which it was generated to validate a login, while a website holds only the corresponding public key, stored as 
part of the user’s account. 

To use a passkey, the first step is to enroll at a website or in an app. You’re likely familiar with this process from any time you signed up for two-
factor authentication at a site: you log in with existing credentials, enable 2FA, receive a text message or scan a QR code into an authentication app 
or your keychain (in iOS 15, iPadOS 15, and Safari 15 for macOS), and then verify your receipt. 

With a passkey, the process is different. When you log in to a website offering passkey authentication, you will have an option to upgrade it to a 
passkey in your account’s security or password section. The website first generates a registration message that Apple’s operating systems will inter-
pret—it happens at a layer you never see. In response, your device creates the public/private key pair, stores it securely and locally, and transmits the 
public key to the website. The site can then optionally issue a challenge for it and your device can present it to confirm the enrollment. 

On subsequent visits, when you’re presented with a login, your iPhone or iPad will show the passkey entry in the QuickType bar and Safari in 
macOS will show it as a pop-up menu. In both cases, that’s just like passwords and verification codes today. As with those login aids, you’ll validate 
the use of your 
passkey with Touch 
ID, Face ID, or your 
device passcode, de-
pending on your set-
tings. 

Behind the scenes, 
your request to login 
via a passkey causes 
the site server to gen-
erate a “challenge” 
request using the 
stored public key. Your 
device then has to 
build a response using 
your stored private 
key. Because you initi-
ate a passkey login by 
validating your identi-
ty, your device has 

Source: Apple

https://fidoalliance.org/
https://www.yubico.com/why-yubico/how-the-yubikey-works/
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access to your passkey’s private key when the challenge request comes in and can respond to the challenge without another authentication step. The 
server validates your device’s response against your stored public key, ensuring that you are authorized for access. If it all checks out, the website logs 
you in. 

A passkey replaces two-factor authentication, and it’s worth breaking down why, as it seems counter-intuitive: how can a single code held on a de-
vice provide distinct aspects of confirmation? The rubric for multiple security factors is usually stated as at least two of “something you know, some-
thing you have, or something you are.” A passkey incorporates at least two of those: 
• Something you know: While commonly thought of as a password, the “know” part is really any fixed piece of information you possess. Think of 

a 20-character randomly generated password stored in your password manager. Do you “know” that? Yes, in the sense that it’s retrievable exactly as 
entered. 

• Something you have: Because passkeys are locked to devices, you prove your possession of a device by unlocking the passkey: no device, no 
passkey. 

• Something you are: Although passkeys don’t require biometric authentication using Face ID or Touch ID, it’s an option. Apple always lets you 
use a device passcode to backstop Face ID or Touch ID, so it’s a blurred line with “something you know” compared to a dedicated biometric de-
vice with no fallback option. 

• Think for a moment about the advantages here. A passkey: 
• Resists phishing: As with passwords and verification codes, your device will only present a passkey in QuickType or as a pop-up menu option 

when on a website’s specific domain associated with the passkey. An attacker can’t fool you into entering a passkey on a deceptive site, as can be 
done with a password. 

• Prevents reuse of a stolen key on other accounts: Because each passkey is unique to its associated website, even if the site suffers a security breach, 
the only credential that can be stolen is your public key. That public key is useless to help a thief log in as you at another site as they lack your pri-
vate key to answer the login challenge. 

• Blocks damage from malicious code injection on a website you visit: A malicious party can often “inject” malicious JavaScript onto an other-
wise benign page. It has happened at times even to major websites, usually due to poorly vetted malicious ads delivered automatically through self-
service advertising networks. A website that falls prey to just a front-end attack on its HTML and scripts wouldn’t allow the attacker to produce a 
valid challenge request for your device’s passkey. The site would also have to suffer from a back-end compromise of its server code for account in-
formation to be at risk, at which point the site’s data is probably fully compromised anyway. 

• Blocks guessing, identity searching, brute force: Because every passkey has a super-complex secret, an attacker can’t successfully guess or brute 
force your access to a site. 

• Eliminates 2FA hijacking: Because passkeys don’t have a second factor, they aren’t vulnerable to SMS hijacking and interception, site imperson-
ation and phishing, and other techniques to acquire a second factor. 
Apple stores each passkey as just another entry in your keychain. If you have iCloud Keychain enabled, the passkeys sync across all your devices. 

(iCloud Keychain requires two-factor authentication enabled on your Apple ID; Apple hasn’t said if passkeys will replace its internal use of 2FA for its 
user accounts.) 

You can share a passkey with someone else using AirDrop. This means you have to be in proximity to the other person, another element in securi-
ty. The details are shared through end-to-end encryption, allowing the private key and other data to be passed without risk of interception. Apple 
hasn’t provided much more detail than that AirDrop sharing is an option, so there may be other provisos or security layers. 

Because passkeys replace passwords and a second factor, you may be reasonably worried at this point about losing access to your passkeys if you’re 
locked out of your Apple ID account or lose all your registered devices. Apple has several processes in place for recovering Apple ID account access 
and broad swaths of iCloud-synced data. For an Apple ID account, you can use Apple’s account recovery process or an account Recovery Key. 
For iCloud data, if you’ve enabled the friends-and-family recovery system, iCloud Data Recovery Service, you can use that to re-enable access. After 
you recover account access, Apple has an additional set of steps that enable you to retrieve iCloud Keychain entries: it involves sending a code via 
SMS to a registered phone number and entering a device passcode for one of the devices in your iCloud-synced set. 

This is all a fabulous reduction in the potential for successful attacks against your Internet-accessible accounts. But there’s more: Apple isn’t building 
yet another walled garden. Instead, passkeys are part of a broad industry effort with which Apple says its implementation will be compatible. 

Passkeys Are an Industry Standard, Not a Proprietary Technology 
Apple built its passkey support on top of the previously mentioned WebAuthn standard, which describes the server side of how to implement a 

Web-based login with public-key cryptography. FIDO created standards for the client side of that equation and calls the combination of its protocol 
and WebAuthn FIDO2. Apple developed its own client-side approach that’s compatible with standard WebAuthn servers and should be inter-
changeable with other companies’ rollouts of passkeys. Google, Microsoft, and Apple made a joint announcement in May 2022 committing to 
this approach, too. 

In Apple’s passkey introduction video for developers, engineer Garrett Davidson emphasized Apple’s commitment to compatibility, saying: 
We’ve been working with other platform vendors within the FIDO Alliance to make sure that passkey implementations are compatible cross-plat-

https://www.macworld.com/article/542836/what-you-should-know-about-ios-15-recovery-keys.html
https://www.macworld.com/article/540482/how-to-use-icloud-data-recovery-service.html
https://support.apple.com/en-us/HT213305
https://fidoalliance.org/specifications/
https://fidoalliance.org/apple-google-and-microsoft-commit-to-expanded-support-for-fido-standard-to-accelerate-availability-of-passwordless-sign-ins/
https://developer.apple.com/videos/play/wwdc2022/10092/
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form and can work on as many 
devices as possible. 

He then demonstrated using 
a passkey on an Apple device to 
log in to a website on a PC, 
showing how a QR code could 
be used to enable a passkey login 
to one of your accounts on a 
device or browser that’s not con-
nected to your existing devices or 
ecosystem. 

Here’s how you might log in to 
a passkey-enabled account on 
someone else’s PC using your 
iPhone with your passkey as the 
authenticator. During the login, 
you can opt to add a device in-
stead of entering a passkey or 
other authentication in the 
browser. The website’s server gen-
erates a QR code that includes a 
pair of single-use passwords—
they’re generated just for that 
login and used in the next step 
for additional validation. (Note 
that the device with the browser 
could be any passkey-supporting 
operating system and device. The 
authenticating devices might be 
limited by Apple or other com-
panies to a smaller set, much like 
you can only use an iPhone to 
confirm Apple Pay in Safari on a 
Mac, not a Mac with Touch ID 
to confirm Apple Pay from an 
iPhone.) 

The PC in our example also 
starts broadcasting a Bluetooth 
message that contains the information needed 
to connect and authenticate directly with the 
server. Scan that QR code on your iPhone, 
and the iPhone uses an end-to-end encrypted 
protocol to create a tunnel with the PC’s Web 
browser using the keys shown in the QR code. 
(This encrypted connection isn’t part of the 
Bluetooth protocol, by the way, but data tun-
neled over Bluetooth; Bluetooth doesn’t incor-
porate the necessary encryption strength.) 

This Bluetooth connection provides addi-
tional security and verification by offering out-
of-band elements, or details that the PC isn’t 
presenting to the device that’s providing au-
thentication—here, your iPhone. Because 

FIDO’s schematic for a generalized registration process. (Source: FIDO Alliance) 

https://developer.apple.com/videos/play/wwdc2022/10092/?time=289
https://developer.apple.com/videos/play/wwdc2022/10092/?time=289
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Web pages can be spoofed for phishing attacks, the Bluetooth connection provides a device-to-device backchannel for key details: 
• Server addresses: The QR code doesn’t tell the iPhone what server (or list of servers) it can connect to for the actual passkey connection. That 

prevents a browser from providing malicious information. 
• Key validation: The successful creation of an end-to-end encrypted two-way session over Bluetooth using the keys in the QR code enables the 

iPhone and PC to confirm that the QR code the browser delivered and the iPhone scanned are identical. (Apple hasn’t yet provided full details on 
this stage. The operating system clearly generates the QR code based on a request from the browser, and the browser can’t sniff the Bluetooth con-
nection. So a front-end attack that displayed a malicious QR code wouldn’t work, as the PC and iPhone communicate without the browser in the 
loop.) 

• Proximity: Connecting over short-range Bluetooth demonstrates, with confidence, that the PC and iPhone are near each other. 
This broad device and platform compatibility lets you maintain the same degree of passkey security and simplicity without downgrading to a 

weaker method for login when accessing your account using other people’s devices. Whenever there’s a way to force a weaker login method, malicious 
parties will exploit that via phishing, social engineering, or other interception techniques. (Providing a second factor via an SMS text message versus a 
verification code is a prime example of a weaker backup approach that has been exploited.) In fact, until passkeys can be used exclusively, password-
based logins will have to remain available, and they’ll remain vulnerable. 

There might be some usability hiccups as passkeys roll out, but they shouldn’t be widespread. It’s possible, for instance, that some WebAuthn server 
components will need to be updated or that Apple will have to add more edge cases to its framework to encompass how things work in the wild. 

But imagine a world in which you can securely log in to websites using any current browser on any device running any modern operating system, 
without having to create, remember, type, and protect passwords. It’s relaxing just to think about. 

The main question that remains unanswered is how portable passkeys will be among ecosystems: can I use iOS and Android and Windows and 
share a passkey generated on one among all three? Given that Apple has built an AirDrop-sharing method for passkeys, I hope FIDO’s broad com-
patibility includes sharing passkeys among operating systems, too. 

A Return to Security through Proximity 
Passwords have provided an uneasy security compromise since their introduction decades ago when multi-user computing systems began to re-

quire protection. Passwords are patently imperfect, a relic of an age when physical proximity provided the first level of protection, something rendered 
moot by the Internet. 

In an effort to answer some of the weaknesses in a password system, two-factor authentication was grafted on to require that you had something 
besides a password, something that required holding or being near an object to validate your right to log into a computer, service, or website. But 
because 2FA starts with an account password and uses a second method that can be subject to compromise or phishing, it remains a patch applied to 
a damaged wall. 

The passkey is a modern replacement for passwords that rebuilds the security wall protecting standard account logins. Proximity—in the form of 
the device that stores your passkeys—is a powerful tool in reducing account hijacking and interception. Passkeys may seem scary and revolutionary, 
but they’re actually safer and, in some ways, a bit old-fashioned: they’re a bit of a throwback to a time when having access to a terminal provided proof 
you were authorized to use it. 

WWDC 2022
Seven Head-Scratching Features from WWDC 2022 

by ADAM ENGST 
Had Apple’s WWDC keynote taken place in person, it’s easy to imagine the live audience breaking into applause for some of the previewed 

features. We would have applauded for everything we wrote about in “Ten “It’s About Time” Features from WWDC 2022” (6 June 2022). 
Then there would have been the points where a presenter’s script said “<pause for applause>” but would have been greeted by a silent crowd wear-
ing puzzled expressions. 

Not all of these features are necessarily bad, though some are, and others are just inexplicable. They’re WTF—what the f…eature was Apple 
thinking? 

https://tidbits.com/2022/06/06/ten-its-about-time-features-from-wwdc-2022/
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Apple Pay Later 

Two-thirds of Americans live paycheck to paycheck, 
and now Apple wants to help them buy more stuff they can’t 
afford with Apple Pay Later, which splits purchase prices 
into four interest-free payments. Which you have six 
weeks to pay off. Yes, you read that correctly; you must pay 
off your Apple Pay Later purchases in six weeks, making us 
wonder what the point is. We could see wanting to space out 
payments for an expensive purchase like an iPhone or Mac 
over 12 months, especially if you urgently need to replace a 
machine. But we don’t see how Apple sticking its toe in the 
Buy Now, Pay Later industry helps users make smart finan-
cial decisions, and it’s not a good look for Apple. What’s 
next? Apple Payday Loans? 

Focus Filters 
Focus was the most confusion-generating feature of iOS 15 (see “Apple’s New Focus Feature May Be Overkill,” 20 January 2022), so we were 

hoping for an overhaul in iOS 16 that would reduce complexity. Sometimes Apple doesn’t get it right the first time and has to iterate the next year. 
Instead, Apple has doubled down and made Focus even more convoluted than before. In iOS 16, you’ll be able to add Focus filters, which let you 
display only relevant content, hiding entire calendars, 
email accounts, Mail accounts, Messages conversations, and 
Safari Tab Groups. Imagine the support questions: 
• “Why has my Gmail account disappeared on my iPad?” 
• “Where do my browser tabs keep going?” 
• “I was talking to my spouse in Messages, but now it’s 

gone!” 
Making things even worse will be a personalized setup 

experience that suggests relevant apps, wallpapers, and wid-
gets, along with the new capability to silence notifications 
from apps and people. Typical users already don’t know why 
their devices act in certain ways, and these Focus features will 
make the Apple experience even more unpredictable. If 
you’re willing to accept responsibility for Focus preventing 
you from receiving an important notification or hiding data, 
go nuts, but for most people, we recommend configuring Focus only for Do Not Disturb (while sleeping) and Driving. 

Freeform 
Apple previewed a new digital whiteboard app called 

Freeform that it said would ship sometime before the end of 
the year. (In other words, don’t be surprised if it doesn’t ap-
pear with the initial releases of macOS 13 Ventura, iOS 16, 
and iPadOS 16.) There’s nothing inherently wrong with 
digital whiteboarding—it’s a huge category with entries 
from Google, Microsoft, and a slew of other companies—
but why would Apple bother to get into the space? Only the 
most Apple-centric business or school would look to an 
Apple tool in favor of the Google or Microsoft productivity 
suites that dominate group collaboration scenarios. Anyone 
who does want to go beyond the standard tools already has a 
wide selection of alternatives. What can Apple bring to the 
table other than demo whiteboards that are way prettier than 
any competitor—or user—would ever create? 

https://www.cnbc.com/2022/03/08/as-prices-rise-64-percent-of-americans-live-paycheck-to-paycheck.html
https://www.cnet.com/personal-finance/loans/how-iphones-new-apple-wallet-feature-lets-users-buy-now-pay-later/
https://www.cnet.com/personal-finance/loans/how-iphones-new-apple-wallet-feature-lets-users-buy-now-pay-later/
https://tidbits.com/2022/01/20/apples-new-focus-feature-may-be-overkill/
https://www.macrumors.com/2022/06/07/apple-improves-focus-modes/
https://www.google.com/search?q=digital+whiteboard+apps
https://jamboard.google.com/
https://www.microsoft.com/en-us/microsoft-365/microsoft-whiteboard/digital-whiteboard-app
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Next-Generation CarPlay 

During the keynote, Apple put quite a bit of effort into 
demoing a massive update to CarPlay. Apple envisions that 
cars of the future will use screens for the instrument cluster 
and environmental controls, not just the infotainment sys-
tem as today. As such, the next-generation version of CarPlay 
will enable users to reconfigure what information displays on 
each screen, customize the look, and more. 

The only catch? Cars that support it won’t start appearing 
on the market until the end of 2023, which means that it 
could be another few more years—or more—before this 
level of CarPlay support is commonplace. Why is Apple 
talking about this years before it will be a reality, especially 
given how infrequently most people buy cars? We presume 
Apple is trying to establish its credentials in the car market 
ahead of the eventual release of the much-rumored Apple Car. Or perhaps Apple’s looking for an onramp into the automotive world by licensing a 
full carOS to carmakers? 

Plus, this vision of CarPlay raises some important questions about car interfaces. It could be good if you could take your custom interface from car 
to car (especially rental cars), but will CarPlay surface everything that the car’s native interface can do? (We presume that cars will still have native in-
terfaces, even if they’re equally screen-based.) And, to raise the usual bogeyman, what if your phone crashes or runs out of power while you’re driving? 
CarPlay is a great add-on, but we’re not sure we’d want to rely on it for safety-related features. 

Customize Spatial Audio with TrueDepth Camera 
This announcement came and went fairly quickly, but it 

had us scratching our heads immediately. The idea, it seems, 
is that spatial audio sounds more realistic if it can take into 
account aspects of the physicality of the listener that affect 
their perception of space. Apparently, this is a thing—
called Head-Related Transfer Functions—and by capturing 
data using the iPhone’s TrueDepth camera, Apple could 
personalize the otherwise average HRTF that combines data 
from thousands of people. We’re not arguing that this is pos-
sible, but is spatial audio that big of a deal, and will personal-
izing make enough difference to justify training your iPhone 
(much less Apple’s development effort)? We have plenty of 
ideas for things Apple could do that would have a greater 
impact on more users—see “Five Enhancements for Fu-
ture Apple Operating Systems” (19 May 2022). 

Handoff for FaceTime 
We hope that this feature—handing off a FaceTime call 

from one Apple device to another—was easy to implement 
because it’s hard to imagine it getting all that much use. 
Apple’s pitch sounds attractive but doesn’t make much sense 
under scrutiny. Who is going to get a FaceTime call while 
out of the house and then manage to keep it going while 
juggling keys and opening doors, setting down packages, 
and taking off shoes and coats, all so you can get to your 
Mac, wake it up, and transfer the call to a computer with a 
worse camera? (It’s marginally more understandable if the 
iPhone automatically invokes Continuity Camera to be-
come your Mac’s webcam in the process.) We’d just hang up 
and call back. The main win here would seem to be switching 

https://www.whathifi.com/us/news/apples-ios-16-will-let-users-personalise-spatial-audio-for-airpods-with-the-iphones-truedepth-camera
https://tidbits.com/2022/05/19/five-enhancements-for-future-apple-operating-systems/
https://tidbits.com/2022/05/19/five-enhancements-for-future-apple-operating-systems/
https://tidbits.com/2022/05/19/five-enhancements-for-future-apple-operating-systems/
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an iPhone FaceTime call you’ve received while sitting on the couch to a Mac or iPad with better seating ergonomics, which is nice but not world-
changing. 

Safari Shared Tab Groups 
Safari’s Tab Groups have never done much for us. Browser tabs are ephemeral items—we open and close hundreds of them every day—so there’s 

no benefit in organizing them. Worse, Tab Groups don’t even work well. If you have a tab group selected and then click a URL in another app, Safari 
responds by creating a new window for that tab instead of combining it with the current window’s uncategorized tabs. Plus, on one of my two Macs, 
when I accidentally close a tab in a Safari Tab Group and immediately press Command-Z to bring it back, it returns for a second or two and then 
disappears again, with no option to use Undo again. That doesn’t instill confidence. 

Since the initial release of this article, we’ve heard from people who find Tab Groups useful, so our opinion certainly isn’t universal. But if you’re in 
our camp and want to work with a set of Web pages in a way that has more permanence, put bookmarks in a Favorites folder and Command-click 
it to open them all. 

In this year’s operating system updates, Apple said we’ll be 
able to share Safari Tab Groups with friends so that everyone 
can add (and presumably close) tabs in the group while 
working together. It’s possible to construct a use case for why 
a group might want to put together a set of Web pages, but 
if you’re going to make that effort, wouldn’t you want some 
permanence, so one person’s accidental click or Command-
W doesn’t destroy the tab for everyone else? 

We’re not just being curmudgeonly here—many of the 
new features that Apple has slated for macOS 13 Ventura, 
iOS 16, and iPadOS 16 sound great—but when there are 
still plenty of potholes that need fixing, it’s frustrating to see 
Apple focus time and effort on ill-conceived features that we 
doubt will get much usage. 

ExtraBITS 
Defending Ukraine: Microsoft’s Early Lessons from Russia’s Cyberwar — While the Russian military attempts to level Ukrainian cities, Russian 
intelligence agencies have targeted the rest of the world online. Microsoft offers early insights into what its threat intelligence team has learned on the 
digital front lines. 

Apple Invites Top Community Contributors for “White-Glove” Treatment — Apple has announced Apple Community+, an invitation-only 
club for its top contributors, to whom Apple promises special perks.

Reuse governed by Creative Commons license. TidBITS has offered years of thoughtful commentary on Apple and Internet topics. For free 
email subscriptions and access to the entire TidBITS archive, visit www.tidbits.com. 

https://tidbits.com/2022/06/30/defending-ukraine-microsofts-early-lessons-from-russias-cyberwar/
https://tidbits.com/2022/06/30/apple-invites-top-community-contributors-for-white-glove-treatment/
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Membership Application Form 
Membership entitles you to access to our online forums, participation in prize drawings, and access to the bar-
gains in the members area of the SMMUG website at www. smmug.org. SMMUG renewal membership dues 
($30) apply to the calendar year and are paid each December for the following year. Use the following table for 
NEW MEMBERSHIP ONLY: 

 JAN 1 to MAR 31 - $30.00  APR 1 to JUN 30 - $20.00  
  JUL 1 to SEPT 30 - $15.00  OCT 1 to DEC 31 - $10.00 

Please Print Clearly!     Today’s Date  

Name 
 Street Address 
 City/State/ZIP 

 Home Telephone 
 E-mail Address

Have you previously been a member of SMMUG? 
How did you learn about SMMUG? 

Make your check payable to:  SMMUG   
Then mail or give this form and your check to:

SMMUG, Inc.    
2100 Wood Avenue 
Colorado Springs, CO 80907-6718 

Please make an online account for me. 
User Name _______________

Don’t make an online account for me. I 
do not want one or I already have one.

Business Telephone 

About Us 

The Silicon Mountain Macintosh User Group, Inc. (a nonprofit educational corporation) was formed in Colorado Springs, Col-
orado in 1985, and is one of the oldest Macintosh User Groups in the United States. SMMUG, Inc. is dedicated to helping 
members enjoy and learn about their Macintosh computer, iPhone and iPad devices. 

Club membership is open to everyone and you are cordially invited to visit our free monthly General Meeting on the second 
Monday of each month, at 7:00 PM. For those new to the Macintosh, we have a Question & Answer session at 6:00 PM, where 
our collective expertise can help answer your questions.  

All members receive a monthly newsletter, published on our web site, see great reviews of software and hardware, or can partici-
pate in the monthly door prize drawing. Each member gets one vote during annual Officer Elections. No corporate memberships 
are granted. 

Our officers are volunteers and receive no pay. All funds raised are used for the cost of operating the club and its meetings. 

http://www.smmug.org

